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Intended use

This station has been developed and produced solely for vocational and further
training purposes in the field of automation and communication. The company
undertaking the training and/or the instructors is/are to ensure that trainees
observe the safety precautions described in the manuals provided.

Festo Didactic herewith excludes any liability for damage or injury caused to
trainees, the training company and/or any third party, which may occur if the system
is in use for purposes other than purely for training, unless the said damage/injury
has been caused by Festo Didactic deliberately or through gross negligence.
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1. Introduction

The Festo Didactic Learning System for Automation is designed to meet a number of
different training and vocational requirements. The systems and stations of the
Modular Production System (MPS®) facilitate industry-orientated vocational and
further training and the hardware consists of didactically suitable industrial
components.

The Storing station provides you with an appropriate system for practice-orientated
tuition of the following key qualifications

e Social competence,
e Technical competence and
e Methodological competence

Moreover, training can be provided to instil team spirit, willingness to cooperate and
organisational skills.

Actual project phases can be taught by means of training projects, such as:

e Planning,

e Assembly,

e Programming,

e Commissioning,
e Operation,

¢ Maintenance and
e Fault finding.

© Festo Didactic GmbH & Co. KG ® 696683 5



1. Introduction

1.1
Training contents

Training contents covering the following subjects can be taught:

e Mechanics
- Mechanical construction of a station
e Pneumatics
- Piping connections of pneumatic components
- Pneumatic grippers
- Pneumatic linear drives
e Electrical
- Correct wiring of electrical components
- Connection of DC motors
- Activation of DC servo motors
- Usage of linear drives
- Usage of motor controller
- 1/0 activation of a drive controller
e Sensors
- Correct use of limit switches
- Mode of operation and areas of application of optical and inductive sensors
with digital switching behaviour
e PLC
- Programming and use of a PLC
- Structure of a PLC program
- Programming of positioning control systems
- Programming a storage administration
- Programming a Teach-function
- Programming of alternative (OR) branches
e Handling
- Positioning of DC servo motor
- Usage of a parallel gripper
e Storing
- Storage administration and organisation
o Commissioning
- Commissioning of a production system
- Commissioning of electric axis
e Fault finding
- Systematic fault finding on a production system
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1. Introduction

Topics for project work

Selection and use of various pneumatical drives
- Linear drives
- Parallel gripper
e Selection and use of various electrical drives
e PLC programming
- Programming of counters
- Programming of an intermediate buffer for workpiece parameters
- Programming of an operational section
- Programming of a RESET sequence
- Programming of a EMERGENCY-STOP sequence
e Drive engineering
- Configuration of electrical drives
- Usage of drive controllers
- Reference drive
- Configuration of speed and acceleration profiles
- Teach in of positions
- Positioning a linear drive with DC servo motors
e Optimising cycle time
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1. Introduction

1.2
Important notes

1.3
Duty of the operating
authority

1.4
Duty of trainees

The basic requirement for safe use and trouble-free operation of the MPS® is to
observe the fundamental safety recommendations and regulations.

This manual contains important notes concerning the safe operation of the MPS®.

The safety recommendations in particular must be observed by anyone working on
the MPS®.

Furthermore, the rules and regulations for the prevention of accidents applicable to
the place of use must be observed.

The operating authority undertakes to ensure that the MPS® is used only by persons
who:

e are familiar with the basic regulations regarding operational safety and accident
prevention and who have received instructions in the handling of the MPS®,

e have read and understood the chapter on safety and the cautionary notes in this
manual.

Safety-conscious working of the persons should be regularly vetted.

Prior to commencing work, all persons assigned to working on the MPS® have a duty
to:

e read the chapter on safety and the cautionary notes in this manual and,

e observe the basic regulations regarding operational safety and the prevention of
accidents.
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1. Introduction

1.5

Risks involved in dealing
with the Modular
Production System

© Festo Didactic GmbH & Co. KG ® 696683

The MPS® is designed according to state of the art technology and in compliance
with recognised safety regulations. However when using the system there is
nevertheless a risk of physical or fatal injury to the user or third parties or of damage
being caused to the machinery or other material assets.

The MPS® is to be used only:

e forits intended purpose and
e inan absolutely safe conditions.

Faults impairing safety must be rectified immediately!



1. Introduction

1.6 In principle all our ,,Terms and Conditions of Sale“ apply. These are available to the

Warranty and liability operating authority upon conclusion of the contract at the latest. Warranty and
liability claims for persons or material damage are excluded if these can be traced
back to one or several of the following causes:

e Use of the MPS® not in accordance with its intended purpose

e Incorrect assembly, commissioning, operation and maintenance of the MPS®

e Operation of the MPS® using faulty safety equipment or incorrectly fitted or non
operational safety or protective devices

e Non observance of notes in the manual regarding transport, storage, assembly,
commissioning, operation, maintenance and setting up of the MPS®

e Unlawful constructional modifications on the MPS®

¢ Inadequate monitoring of components subject to wear

e Incorrectly carried out repairs

o (atastrophies as a result of foreign bodies and vis major.

Festo Didactic herewith rules out any liability for damage or injury to trainees, the
training company and/or other third parties which may occur during the
use/operation of the system other than purely in a training situation, unless such
damage has been caused intentionally or due to gross negligence by Festo Didactic.

1,7 This system has been developed and produced exclusively for vocational and further

Intended use training in the field of automation and technology. The training authority and/or the
instructors is/are to ensure that trainees observe the safety precautions described
in the manual provided.

The use of the system for its intended purpose also includes:

o following all advice in the manual and
e carrying out inspection and maintenance work.
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2.
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Notes on safety

General

e Trainees must only work on the station under the supervision of an instructor.

e Observe the data in the data sheets for the individual components, in particular
all notes on safety!

Electrics

e Electrical connections are to be wired up or disconnected only when power is
disconnected!

e Use only low voltages of up to 24 V DC.

Pneumatics

e Do not exceed the permissible pressure of 8 bar (800 kPa).

e Do not switch on compressed until you have established and secured all tubing
connections.

e Do not disconnect air lines under pressure.

e Particular care is to be taken when switching on the compressed air. Cylinders
may advance or retract as soon as the compressed air is switched on.

Mechanics
e Securely mount all components on the plate.
¢ No manual intervention unless the machine is at rest.

11



2. Notes on safety
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3. Technical data

31

Combinations

mps®

station

Parameter Value
Operating pressure 6 bar (600 kPa)
Voltage supply 24V DG 4.5A
Digital inputs 8

Digital outputs 8

Possible direct MPS® downstream stations
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3. Technical data

3.2
Configuration
MTR-DCI/SFC-DC

14

Configuration controller MTR-DCI

Parameter Configuration

Motor type MTR-DCI-42S-VCSC-EG14-H210
Motor size 42

Gear type G14-14:1

Interface type 10 Multipole 1/0

Homing method

Reference switch positive

Axis zero point -16,6 °
Homing velocity v_rp 30,0°/s
Homing velocity v_zp 30,0°/s
Relative motor current 80 %

Axis type Rotating axis
Working stroke 1500,0°
Software limit positive 10,0 °©
Software limit negative -140,0°

Gear factor 2,000
Configuration controller SFC-DC

Parameter Configuration

Controller type

SFC-DC-VC-3-E-H2-10

Homing method

Block negative

Axis zero point 1,00 mm
Homing velocity v_rp 10,0 mm/s
Homing velocity v_zp 10,0 mm/s
Relative motor current 70 %

Axis type Festo mini slide SLTE

Axis size SLTE-16-150-L57,5-DC-VCSC-GO4
Software limit positive 150,00 mm

Software limit negative 0,00 mm

Controller adjustment Middle
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4. Transport/Unpacking/Scope of delivery

Transport
The MPS® is delivered in a container with a pallet base.

The container must be transported on a suitable fork lift truck at all times and must
be secured against tipping or falling off.

The carrier and Festo Didactic are to be notified immediately of any damage caused
during transport.

Unpacking

Carefully remove the padding material in the container box when unpacking the
station. When unpacking the station, make sure that none of the station assemblies
have been damaged.

Check the station for any possible damaged once unpacked. The carrier and Festo
Didactic are to be notified immediately of any damage.

Scope of delivery

Check the scope of delivery against the delivery note and the order. Festo Didactic
must be notified immediately of any discrepancies.

© Festo Didactic GmbH & Co. KG ® 696683 15



4. Transport/Unpacking/Scope of delivery
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5. Design and function

y

5.1
The Storing station
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Storing combines the handling functions storing and testing.

According to VDI 2860, that means storing of parts in order of required defined
characteristic categories, measured through information acquisition (ACTUAL) and
the comparison with specified characteristics (REQUIRED). Viewing a total sequence
the storing station can be used as a store-in or a store-out unit.

During the storing sequence inserted symbolic workpieces are detected by a colour
sensor and deposited into one of three levels of a rack module, depending on the

colour.

During the retrieving sequence required symbolic workpieces are removed from a
rack module and transported to a downstream station.

© Festo Didactic GmbH & Co. KG ® 696683 17



5. Design and function

The function of the Storing station is to

o distinguish workpieces according to colour
e storing of workpieces or
o retrieving of workpieces

The Storing station consists of the following:

e Holder module
e Storage module
e Rack module

e Profile plate

e Trolley
e (Control console
e PLCboard

Storing station with trolley, control console and PLC board

18
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5. Design and function

5.2 Storing

Function The Storing station detects the colour of incoming workpieces and deposits them
into one of three levels of the rack module, depending on the colour (black, red,
silver). A colour sensor detects workpieces inserted onto the Holder module and
controls the further process sequence.

Detected workpieces are picked-up by the pneumatic gripper and will be transported
to the next free shelf of the corresponding rack level via Storage module.
Each rack level can accommodate six workpieces (black, red, silver).

Retrieving

In case of a material request from the downstream station, workpieces (black, red,
silver) are picked-up by the pneumatic gripper, are removed from the Rack module
and transported to the downstream station via Storage module.

5.3 Start prerequisites storing
Sequence description e Workpiece in the Holder module

Initial position storing

e Storage module in position G5 (colour identification)
e Mini slide SLT advanced

e Gripper open

Sequence storing

Workpiece detected

Colour identification

Storage module to position G7 (Holder module)
Gripper closed

Storage module to position G6 (height 6)

Mini slide SLT retracted

oV EWwWNRE
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5. Design and function

Black workpiece detected, storing to rack level 1

7. Storage module to position free shelf (rack level 1, height 1)
8. Mini slide SLT advanced

9. Storage module to position free shelf (rack level 1, height 2)
10. Gripper opened

11. Mini slide SLT retracted

12. Initial position

Silver workpiece detected, storing to rack level 2

13. Storage module to position free shelf (rack level 2, height 3)
14. Mini slide SLT advanced

15. Storage module to position free shelf (rack level 2, height 4)
16. Gripper opened

17. Mini slide SLT retracted

18. Initial position

Red workpiece detected, storing-to rack level 3

19. Storage module to position free shelf (rack level 3, height 6)
20. Mini slide SLT advanced

21. Storage module to position free shelf (rack level 3, height 7)
22. Gripper opened

23. Mini slide SLT retracted

24. Initial position

20 © Festo Didactic GmbH & Co. KG ® 696683



5. Design and function

Start prerequisites retrieving
e Material request from downstream station

Initial position retrieving

e Storage module in position G5 (colour identification)
e Mini slide SLT advanced

e Gripper open

Sequence retrieving
1. Material request detected
2. Minislide SLT retracted

Retrieving black workpiece, rack level 1

Storage module to position full shelf (rack level 1, height 2)
Mini slide SLT advanced

Gripper closed

Storage module to position full shelf (rack level 1, height 1)
Mini slide SLT retracted

Storage module to position H6 (height 6)

. Storage module to position H7 (pick-up point)

10. Gripper opened

11. Storage module to position H6 (height 6)

12. Initial position

© @ NV W

Retrieving silver workpiece, rack level 2

13. Storage module to position full shelf (rack level 2, height 4)
14. Mini slide SLT advanced

15. Gripper closed

16. Storage module to position full shelf (rack level 2, height 3)
17. Mini slide SLT retracted

18. Storage module to position H6 (height 6)

19. Storage module to position H7 (pick-up point)

20. Gripper opened

21. Storage module to position H6 (height 6)

22. Initial position

© Festo Didactic GmbH & Co. KG ® 696683 21



5. Design and function

22

Retrieving red workpiece, rack level 3

23.
24,
25.
26.
27.
28.
29.
30.
31.
32.

Storage module to position full shelf (rack level 3, height 7)
Mini slide SLT advanced

Gripper closed

Storage module to position full shelf (rack level 3, height 6)
Mini slide SLT retracted

Storage module to position H6 (height 6)

Storage module to position H7 (pick-up point)

Gripper opened

Storage module to position H6 (height 6)

Initial position

Notes

In case of a full rack level (counter reading 6) the Storage modaule is set off after
finished store-in sequence. The indicator light “Rack module full“ is illuminated.
In case of an empty rack level (counter reading 0) the Storage module is set off
after finished store-out sequence. The indicator light “Rack module empty*“ is
illuminated.
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5. Design and function

5.4
Holder module

The workpieces are inserted manually or by forward upstream station into the
Holder module.

The workpieces in the holder are detected by a colour sensor (diffuse sensor with
white light) and replaced by a pneumatic gripper (see Storage module).

© Festo Didactic GmbH & Co. KG ® 696683
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5. Design and function

5.5
Storage module

24

The storage module is used to identify, to store and to retrieve workpieces.

A colour sensor (diffuse sensor with white light) detects the colour characteristics
(black, red, silver) and controls the further store-in process sequence.

In case of storing operation mode detected workpieces are picked-up by the
pneumatic gripper and will be transported to the next free shelf of the corresponding
rack level via Storage module (operating mode Store-in) or. In case of retrieving
operation mode requested workpieces are picked-up by the pneumatic gripper and
will be transported to the downstream station via Storage module.

The rotary drive is executed by an electrical servo motor with integrated controller.
The linear drive is executed by an electrical linear axis with separate controller.

© Festo Didactic GmbH & Co. KG ® 696683



5. Design and function

5.6
Rack module

s

The rack module is used for storage symbolic workpieces.
Six workpieces (black, red, silver) can be deposited in each of the three rack levels.

It is possible to deposit 18 workpieces.

© Festo Didactic GmbH & Co. KG ® 696683 25



5. Design and function
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6. Commissioning

The stations of the MPS® are generally delivered

e completely assembled

e operationally adjusted as single station
e commissioned

e tested

Note
If stations are combined changes of the mechanical set-up and the position and
setting of sensors may be necessary.

The commissioning is normally limited to a visual check to ensure correct tubing
connections/wiring and supply of operating voltage.

All components, tubing and wiring is clearly marked so that all connections can be
easily re-established.

6.1 The following is required to commission the MPS® station:
Workstation

e The assembled and adjusted MPS® station

e Acontrol console

e APLCboard

e Apower supply unit 24 VDC, 4.5 A

e Acompressed air supply of 6 bar (600 kPa), approx. suction capacity of 50 |/min

e APCwith installed PLC programming software

© Festo Didactic GmbH & Co. KG ® 696683
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6. Commissioning

6.2
Mechanical set up

28

6.2.1 Assembling profile plate and control console

A VT~ W N R

Profile plate

T-head nut M6 x-32 (4x)
Trolley

Socket head screw M6x10 (4x)
Screw 3.5x9 (2x)

Control console
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6. Commissioning

6.2.2 Assembling the station

Instructions on assembling the station please find in the assembly instructions of
the Separating station in the directory “Technical documentation\Assembly

instructions”.

v

A

Y o
4 (B

:
—")))
FITFTIETIITTITTIIFTITIITLL 1 <

¢
)y BB T
X/

¢ ..1

29

© Festo Didactic GmbH & Co. KG ® 696683



6. Commissioning

6.3 6.3.1 Inductive proximity sensor (Storage module, rotary drive)

Adjust sensors
The proximity sensor is used for sampling the rotary drive reference point.
Inductive proximity sensors detect metallic objects. The switching distance is a
function of material and surface finish.

Prerequisite
- Storage module is assembled

Execution

1. Move the rotary drive, to the pick-up point downstream station, by hand
(rotary position H, reference point).

2. Assemble the proximity sensor in the mounting bracket. Position the proximity
sensor centred above the positioning screw on the module base . The distance
proximity sensor — positioning screw is about 1 mm.

3. Tighten the clamping nuts with a fork spanner (size 13) until the proximity
sensor is fixed.

4. Check position and setting of the proximity sensor by rotary drive reference (for
more details see chapter 6.9.5 MTR-DCI/SFC-DC motor controller or the FCT-
Help).

Documents
e Data sheets

Proximity sensor, inductive SIEN-M8B-PS-S-L (150395)
e Operating instructions

Motor unit MTR-DCI (539616)

Motor controller SFC-DC (540418)
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6. Commissioning

6.3.2 Colour diffuse sensor (Storage module, colour identification)

The diffuse sensor is used to identify the colour of workpieces. The fibre optic device
emits visible white light. The diffuse sensor detects the light reflected by the
workpiece. Different surfaces or colour changes the amount of reflected light.

Prerequisite

Storage module is assembled, colour sensor is pre-assembled.
Mini slide is tubed up.

Compressed air supply switched on.

Storage module and colour sensor are wired up.

Power supply unit switched on.

Execution Teach-In black workpiece

1.

© Festo Didactic GmbH & Co. KG ® 696683

Move the rotary drive into position “pick-up point“ (position set 14, rotary
position G), move the linear drive into position “measuring point“ (position
set 5, measuring point-colour identification) and extend the cylinder piston
using the manual override of the solenoid valve.

Deposit a black workpiece into the Holder module.

Push the SET-key for 3 s (green LED goes off, LED CH1 lights up yellow).
Push the TOGGLE-key to select colour channel CH1

(only LED CH1 lights up yellow).

Push the SET-key for 3 s to confirm the selected channel

(green LED and middle red LED light up).

If necessary select another tolerance level by means of the TOGGLE-key
(standard setting: tolerance 3, middle channel LED)

Note
The green LED serves as a guideline. If it doesn’t light up, the tolerance level is

too low and has to be increased until the green LED lights up.

Push the SET-key for 3 s to confirm the tolerance selection
(green LED and LED CH1 light up).
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6. Commissioning

Execution Teach-In red workpiece
8. Deposit a red workpiece into the Holder module.
9. Push the SET-key for 3 s (green LED goes off, LED CH1 lights up yellow).
10. Push the TOGGLE-key to select colour channel CH2
(only LED CH2 lights up yellow).
11. Push the SET-key for 3 s to confirm the selected channel
(green LED and middle red LED light up).
12. If necessary select another tolerance level by means of the TOGGLE-key
(standard setting: tolerance 3, middle channel LED)
13. Push the SET-key for 3 s to confirm the tolerance selection
(green LED and LED CH2 light up).

Execution Teach-In silver workpiece
14. Deposit a silver workpiece into the Holder module.
15. Push the SET-key for 3 s (green LED goes off, LED CH1 lights up yellow).
16. Push the TOGGLE-key to select colour channel CH3
(only LED CH3 lights up yellow).
17. Push the SET-key for 3 s to confirm the selected channel
(green LED and middle red LED light up).
18. If necessary select another tolerance level by means of the TOGGLE-key
(standard setting: tolerance 3, middle channel LED).
19. Push the SET-key for 3 s to confirm the tolerance selection
(green LED and LED CH3 light up).
20. Control the settings by deposition of silver, red and black workpieces.

Note
All workpieces should be detected securely.

Documents
e Data sheets

Diffuse sensor SOEC_RT_Q50 (538236)
e Operating instructions

Diffuse sensor SOEC_RT_Q50 (675814)
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6. Commissioning

6.3.3 Proximity sensor (Storage module, mini slide)

The proximity sensors are used for end position sensing of the cylinder. The
proximity sensor is sensitive to a permanent magnet mounted on the piston of the

cyli

nder.

Prerequisite

Storage module is assembled, proximity sensors are pre-assembled.
Mini slide is tubed up.

Compressed air supply switched on.

Proximity sensor is wired up.

Power supply unit switched on.

Execution

1.

Use the manual override of the solenoid valve to place the cylinder piston in the
position which you wish to interrogate.

2. Shift the sensor along the cylinder axis until it switches, switching status display
(LED) is on.

3. Shift the sensor a few millimetres further in the same direction until it switches
back (LED is off).

4. Place the switch half the way between the switch-on and the switch-off position.

5. Tighten the clamping screw of the sensor with a hexagon screwdriver A/F 1.3.

6. Start a test run to check if the sensor switches at the correct point
(advance/retract cylinder piston).

Documents

© Festo Didactic GmbH & Co. KG ® 696683

Data sheets
Proximity sensor SME-10 (525914)
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6. Commissioning

6.4 One-way flow control valves are used to regulate exhaust air flow rates with double-
Adjusting one-way flow acting cylinders. In the reverse direction, air flows through the non-return valve with
control valves full cross-sectional flow.

Uncontrolled supply air and controlled exhaust hold the piston between air cushions
(improves motion, even with load changes).

Prerequisite
- Cylinder is tubed up
- Compressed air supply switched on.

Execution

1. Screw in the restrictors of the one-way flow control valves at first completely
and then loosen again one turn.
Start a test run.
Slowly open the one-way flow control valves until the desired piston speed is
reached.

Documents
e Data sheets

One-way flow control valve (175056)
e Operating instructions

Pneumatic cylinders (391172)

6.5 Avisual check must be carried out before each commissioning!
Visual check
Prior to starting up the station, you will need to check:

e The electrical connections
e The correct installation and condition of the compressed air connections
e The mechanical components for visual defects

(tears, loose connections etc.)

Eliminate any damage detected prior to starting up the station!
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6. Commissioning

6.6
Cable connections

Cable connections from PLC board to control console and station

PLC board - station

Plug the XMA2 plug of the PLC board into the XMA2 socket of the 1/0 terminal of the
station.

PLC board - control console

Plug the XMG1 plug of the PLC board into the XMG1 socket of the control console.
PLC board — power supply unit

Plug the 4 mm safety plugs into the sockets of the power supply unit.

PC-PLC

Connect your PC to the PLC by means of a programming cable.

© Festo Didactic GmbH & Co. KG ® 696683 35



6. Commissioning

6.7
Pneumatic connection

6.8
Voltage supply

36

e Observe technical data!
e Connect the compressed air supply to the start-up valve with filter-control valve.
e Set the start-up valve with filter-control valve at 6 bar (600 kPa).

6.7.1 Manual override

The manual override is used to check the functioning and operation of the valves
and valve-drive unit combination.

Prerequisite
- Compressed air supply switched on.
- Power supply unit switched on.

Execution

1. Switch on the compressed air supply

2. Press down the stem of the manual override with a blunt pencil or a screwdriver.
(max. width of blade:2.5mm)

3. Release the stem (the spring resets the stem of the manual override back to the
starting position), the valve moves back to the starting position.
(not with double solenoid valves!)

4. For locking manual override usage: Check all manual overrides for being in
starting position after testing the valves.

5. Before commissioning the station make sure that all valves of the valve terminal
are in starting position.

Documents
e Operating instructions
CPV valve terminal (165100)

e The stations are supplied with 24 V DC voltage (max. 4.5 A) via a power supply
unit.
e The voltage supply of the complete station is effected via the PLC board.
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6.9
Loading the PLC program

6.9.1 Siemens controller

v A W N -

Controller: Siemens S7-313C, S7-313C-2DP, S7-314 or S7-315-2DP
Programming software: Siemens STEP7 Version 5.1 or higher

Connect PC and PLC using the RS232 programming cable with PC adapter

Switch on power supply unit

Switch on the compressed air supply

Release the EMERGENCY-STOP pushbutton (if available)

Overall reset PLC memory:

- Wait until the PLC has carried out its test routines.

CPU 31xC

—  Press the mode selector switch to MRES. Keep the mode selector switch in
this position until the STOP LED comes on for the second time and stays on
(this takes 3 sec.). You can let go of the mode selector.

—  Within 3 sec. you must press the mode selector switch back to MRES. The
STOP LED starts to flash rapidly and the CPU carries out a memory reset.
You can let go of the mode selector.

—  When the STOP LED comes on permanently again, the CPU has completed
the memory reset.

— The data on the MMC (Micro Memory Card) are not deleted. This can be
done by switching to the connected PLC via menu "PLC / Display Accessible
Nodes" and deleting all blocks in the block folder.

CPU31x

—  Turn the mode selector switch to MRES and keep the mode selector switch
in this position until the STOP LED comes on for the second time and stays
on.

— Let go of the mode selector switch to STOP. Immediately you must turn the
mode selector switch back to MRES. The STOP LED starts to flash rapidly.

—  You can let go of the mode selector switch.

—  When the STOP LED comes on permanently the memory reset is completed.

— The PLCis ready for program download.

Mode selector switch in STOP position

Start the PLC programming software
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6. Commissioning

8. Retrieve the file MpsC.zip

Note
Do not unzip the following ZIP-Files using WinZip® or similar software.
Please use the Siemens Software STEP7 instead.

K SIMATIC Manager

Fie PLC View Options Window Help

Labeling Figlds..,
Prink Setup...

1 MPSVersC3 \S7pr
2 MPSVersC314 (Projekt) - D:\THRIS7\MPSVERSC
3MPS_PLUS_IO_V1_1B (Projekt) -- C:\...\Step7\S7projiMPS_PLUS
4 MPSVersC314 (Projekt) -- Di\THR|S7 RobbilMPSVERSC

Exit Alt+F4.

Gets obiect from the archive.

File > Retrieve ... > Select an archive MpsC zip Open > Select destination directory OK - Retrieving: The
retrieved data were stored in the project directory. OK - Retrieve: The following objects were retrieved. Do you
want to open these now? Yes

9. Select the hardware configuration and download it to the controller:
-PLC313C
—PLC313C2DP
-PLC314
—PLC 315 2DP
10. Select the projekt 13LA_OUT_AS or 13LA_OUT_KFA for retrieving
or
select the projekt 13LA_IN_AS or 13LA_IN_KFA for storing
(AS = sequential function chart, KFA = Ladder diagram/Function block
diagram/Instruction list)
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11. Download the project to the controller

Kl SIMATIC Manager - MPSVersC314
PLC View Options Window Help

fccess Rights <NoFiter> 19| 8@ |

ersC31 Upload =
= 39 MPSVers(  Upload Station
= Copy RAM ta ROM...
_\| Dowrioad User program to memory card

|| 5eve Profect o Memory Card),
Retriey Project from Memory Card,,

erane 117 System.
Display Accessible Nodes

. CPUMessages...
| Display Force Walies
_ MonitorjMadify Variables

Prepare Line Diagnostics,
Hardware Diagnostics
" Madue Information...
Operating Mode. .
T ClearjReset...
et Time of Day...

Assign Ethernet Address..
Assign PROFIBUS Address...
As5in PGIPC

Cantel PGIPC assianmert
Update Operating System, .

Downloads current object to the PLC.

PLC - Download = Follow the instructions on the screen

12. Turn the mode selector switch of the CPU to RUN position
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6.9.2 Festo controller

Controller: Festo FEC FC640, IPC CPU HC02, IPC CPU HC20
Programming software: Festo FST Version 4.02

Connect PC and PLC using the TTL-RS232 programming cable
Switch on power supply unit

Switch on the compressed air supply

Release the EMERGENCY-STOP pushbutton (if available)
Wait until the PLC has carried out its test routines

Start the PLC programming software

Restore the file 13LA_FEC.zip

NowykhwNe

ST
Project Edt View Insert Program Online Extras Window Help

e e eIy -rRE

Make Project F7
Buid Project
Clezn Lp

i e

Restore & backed up project

Project > Restore ... > Open 13LA_FEC.zip Open - Restore Project, Name: 13LA_FEC OK
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8. Compile the project

Lzl
Project Edit View Insert Program Online Extras Window Help

- I -
RE=TE

Btion

' (v1) - Mainprogram
(¥1) - sequence program

Compile al programs and prepare the project for download e

Project - Build Project

9. Download the project to the controller

GFST - 1VE_FEC (Kein Kommentar) - FEC Standard =l81x|
Project Edt View Insert Program | Online Extras Window Help

DS E@|X &
=

Project Documentation
Allocation List

=[] Programs D
I [ program 0 (¥1) - Mainpr:
1

Program 1 (¥1) - sequer

2 cmps. e
Cacrms Editor
) controller Settings Orline
2 10 Configuration =
&2 Driver Configuration Sz

Unsianed
Hexadecimal
Gota
Change Update Speed,.,

B program z! Z g B cme 1(v1)- ! zg ! Me,sagnwr ! : g & program E! z g Bcme u(vx)‘ ! : g

Online > Download Project > Follow the instructions on the screen
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6.9.3 Allen Bradley controller

e Controller: Micrologix (ML) 1500
Programming software: RSLogix 500/RSLINXLite

1. Connect PC and PLC using the RS232 programming cable
2. Switch on power supply unit

3. Switch on the compressed air supply

4. Release the EMERGENCY-STOP pushbutton (if available)
Note

e Condition for the following operating steps is to configurate the necessary online
parameter (nodes, devices) with RSLINXLite/RSLogix 500!

o After using shutdown and exit RSLogix 500 and RSLINXLite to avoid conflicts with
the serial interface!

CPU ML 1500 - Onlineparameter configuration
- Wait until the PLC has carried out its test routines.
- Start the RSLINXLite software.

igix

Fle View Communications Station DDEJOPC Securlty Window Help

Available Diiver Types
Clase
Device Name: 4B_DF1-1
R3-232 DF1 devices - Add New ‘ L
[ A ] |
EetE e EEs Comm Port: [COM1 = Devies: [SLCcHOMicro/Panetview x|
Name and Description | Status |
Corfi
orfiaure: BadRae [0 =] Staton Number: [57———
{Decimal)
Startup..
Parity [ Hone - Enor Checking: [CAC 2
Start

Stop Stop Bits: [1 ~ Protocot [Ful Duplex >
IAuLu Carfiguration Suzcessful

™ Use Modem Disler Configure Disler

ancel | Delete | Help

Communications > Configure Drivers... > Select the setting “RS-232 DF1 devices” from the list
“Available Driver Types“ and click Add New... - Confirm note (“Choose a name...“, default: AB_DF1-1)
with OK - Auto configure > OK > Close
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6. Commissioning

' RSLogix 500
Fle View Comms

Start the PLC programming software

=1

Tooks Window Help

|0 = E|&E] 8B e | ok B a s anEe -
1 q

i

Driver. AB_DF1 T Node : 1d 4> \vser LBt £ TmeriCounter £ nputioutput £ compare |

Communications:

R

Browsing - node 0 found

Curent

Workstation, ARBETTSLAPTOR Address | Device Type | onine Name [ status |
B Linx Gateways, Ethernet
P AB_DFI-1, DH-485
B 00, workstation, DF1-COML
59 01, PicroLogix 1500, MLISO0

oI —— |

Workstation

Eoo

Dovriod

For Help, press F1

Server: RSLinx AP Diiver. AB_DF1-1
Node: |1 Decimal (=1 Octal] Type: SLCG00

Fieply Timeout

[io__ 1see)

I | Applpite Project

;0000 [aPF [READ 4

Comms. - System Comms... 2> Select the required controller and confirm with OK

5. Overall reset PLC memory:

Wait until the PLC has carried out its test routines.

CPU ML 1500

Turn the mode selector switch to REM or PROG.

Start the PLC programming software.

Select Comms - System Comms... - select the required controller and
click Online.

After connection the PLC and the PC select Comms - Clear Processor
Memory and confirm with OK.

When the COMM 0.- LED stops blinking the memory reset is completed.
The PLC is ready for program download.

6. Open the file 13LA_K
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H' RSLogix 500 iaix]
File Yiew Comms Tools Window Help
i T | e NFEE = D e

Backup Project...  Chrk8
ik et

108PP_K
20LVEK

301 VE_K_BAKD9Z
451000000
510FM_K

602 FF

Summary 6o
Exit

Open an existing program 0:0000  [APP [READ

File > Open ... 2> Select a project file 13LA_K - Open

7. Download the project to the controller

' RSLogix 500 - 01 VE_K -0 x|
Fie Edi View Search | Comms Tooks Window Help
NI EETIE I, Fl% & mvE ROz e > ]
OFFLINE MoF  Goerine HOTTO3E 3E O G W e e ]
No Edits Fore Upload.
Diver 0] _ P [\User £Bit £ TimeriCounter A input/Outpt A Compare |
Mode [ P_ORG -- Organisationsprogramm / organi =10 x|
[Calms | e
= Clear Processar Memory. ook Not-fus | Calling Ermezguncy.Stop [
£ Help " Best Not-Aus vor (0-Sigral aen Not-Avus Eingang E1.5) vind der Hot-Aus Bawstein aufgarafen, Dex Not-us Baustein setat die Bedionpultawginge | |
{2 contraler EEPROM... » i o
-4 Contraller Histogran
condition of emergency stop (0-signal at exergency stop iput 11 5)emergency stop program block is called. The progearm block resets the
T Processor Statue et et e Ao s A il e L
43 Function Files HOT-ATS entriegelt /
I 10 Configuretion Emergancy stop
Fred wrlocked Emergency Stop
BE channel configurstion
{22 Program Files 10 [—c
B svso- [t Jump To Subrouting
B sve1- SER File Hunber U4
- LaD2-P_ORG
& LaD 3-P_auTO
& LAD 4-P_EMSTOP
& LADS.P_STOR
& LAD & - P_EMBLINKC
(] Data Fies T
Aiufraf Hotaussonds fanktion f Calling Emesgercy special fax:
B Cross Reference Lisgt Hot-kus vor (0-Signal am Not-kus Eingang E1.5) wird der Not-dus
[ 00- aseane Sonderfiktionshastein
[ 1 -ENGANG anfzemfen. Dieser Banstein lisst die Larpen Q21 und Q2 blirden,
[ s2-sTTUS
I s onig In condition of emergency stop (D-signal at emergency stop input
- IL.S)emergancy stop special fanction program block & callsd. The program block
[ 14 - ZEMAY. lets blink the Lamps Q1 and Q2.
[ cs- ZinERr | —
aoa1 Jump To Sibroutine
I e STELERUNG SER File Mumbex UE
[ w7 - TEGER
Y 6 - RESERVERT
(231 Forca Files Aufiuf Stop J Calling Stop
Licgt Bietitigimg dos Stopptasters vox vird der Stop Baustein aufgerafon. Der Stop Banstein setot F1 ud H2 aumiel. Auerdem wird das
[ co- suseane Ahlanforogranm muickgesetat
0O 1 -EnGENG
{2 Custom Data Monkors: L In comdition of the stop buttton is pressad the emierganey stop programblock is called, The program block ressts Hl und K2, Additional the
- sement id
1 — LY 7] T X AT [T} LIJ
Donninad program ko processor [000:0000 [47F [READ

Comms. > System Comms. - Select controller, click Download > Confirm the following notes
(“Revision note","...sure to proceed with Download?", "...want to go online?") with Yes or OK

8. Turn the mode selector switch of the CPU to RUN position
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6.9.4

Pr

Mitsubishi/MELSEC controller

Controller: Mitsubishi FX1N

ogramming software: GX IEC Developer 6.01 or higher

1. Connect PC and PLC using the R5232/RS422 programming cable with PC

a

v~ WwWN

dapter

Switch on power supply unit

Switch on the compressed air supply

Release the EMERGENCY-STOP pushbutton (if available)
Overall reset PLC memory:

Wait until the PLC has carried out its test routines.

CPU FX1N

6. R

Turn the mode selector switch to STOP.
Start the PLC programming software.
Select Online = PLC Clear = All and confirm with Yes.
The memory reset is completed.
The PLC is ready for program download.
estore the file 13LA_AS.pcd

01 ¥ E_AS - GX IEC Developer —1®1 x|

|| Project Object Edit Took Gnine Debug View Extras Window Help

lzEgR|fmels -« Fo i spuCats mmmn

2lx

&

p:d

4 DUT.

POU.

ag
&
7

ag

W

BEP Project [ T2 Coltree [ B Used by

Library_Pool (2 entries, 09.09.2003 16:24:21)
Parameter (30.11.2004 09:10:33)

Task_Pool (2 entries, 20.00.2004 10:34:29)
O _01 Vertelen (Prio = 31, Event = TRUE, 20.09,2004 10:33:28)

L@ Global_vars (34 entries, 26.11.2004 14:15:58)
I

o Headsr (24 entries, 15.11,2004 14:20:18)
I3 Action_Pool (12 entries, 13,10,2004 11:26:59)

o Header (7 entries, 26.11,2004 10:24:10)
80} Body (FED, 30.11.2004 09:07:41)

W Header (2 entries, 15.10.2004 03:51:12)
00} Body (FBD, 30.11.2004 09:10:32)

o Headsr (18 entries, 26.11.2004 10:35:21)
00} Body (FBD, 30.11.2004 08:08:40)

W Header (4 entries, 15.10.2004 03:51:12)
00} Body (FBD, 16.11.2004 16:44:35)

SPS (05.09.2004 12:30:02)
01 _Distributing {Prin = 31, Event = TRLE, 20.09.2004 10:34:25)
_Pool (0 entries, 09.09.2003 16:24:20)

_Pool (5 entries, 26.11.2004 10:16:21)
P_Auta (PRG, SFC, 08.03.2005 15:35:51)

s Body (SFC, 26.11,2004 10:23:40)

P_EmBiink (FB, FBD, 07.12.2004 14:54:33)

P_Emistop (FE, FBD, 09.09.2004 15:08:17)

P_ORG (PRG, FED, 08.03.2005 15:35:51)

F_Stop (FB, FED, 09,0, 2004 15:08:24)

Ready

Offline

Extras > Project Restore ... > Select a project file 13LA_pcd > Open - Select destination directory OK >
Confirm the following note (“After saving,...”) with OK

7. C
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01 ¥ E_AS - GX IEC Developer 121 x|
| Project Object Edt Took Onine Debug View Extras Window Help
St 5 ) 68 S 8 |G o B B | amm o
Ctr+o
2l
04 20!
3 1 21)
»
Change PLC Type 0:34:29)
C oo = |=TRUE, 20.09.2004 10:34:29)
Build Shift+alt+B TRUE, 20.09.2004 10:33:28)
A 4:20)
= 4 14:15:58)
WL 0:16:21)
Onine Pragram Change  Shft+CirHD £ 3s.5y
S browsenn 4 14:20:18)
Printer Setup... 2004 11:28:59)
Frint Options. 154:33)
Print Preview... 10:24:10)
Erint., 141)
- 108:17)
¥ Change Security Level... 09:51:12)
‘Ml change Passwords. :32)
- |5y
LolFEINOL VE_AS M 10:35:21)
zo\Fan 40
3 FilFRIN(Miksbishi) |01 YE_AS 55294)51 »
4 Fritest1 30
Quit Alt+F4

TP Froject [OF Collree | B Usedby
Rebuilds the project orfine [

Project - Rebuild all

8. Download the project to the controller

ST
| Broject Object Edt Took Onine Debug View Extras Window Help ‘

corten SEHECHEE maom
& Open. ctra

Change PLC Type 0:34:29)

CUEETE SR = TRUE, 20.09.2004 10:34:29)
Buid Shift+alt+s  |TRUE, 20.09.2004 10:33:28)
Rebuid al Shift+atec (02420}

£ Upload from PLs
Online Program Change  Shift-+CEA-D

& Browse...

Printer Setup...

Verify.
Dovnioad Symbolic Infarmations

Copy Program Memary to Flzsh RO,
Print Optians, il i

Prink Preyiew... 10:24:10)
print. 141)

e 3%

F  Change Security Level... 09:51:12)
‘W change Passwords :32)

e e )
LC\FRINIDL YV E_AS 14 10:35:21)
zo\Fan :40)

\FA1N(MEsubishi)|01_VE_AS o:24)
09:51:12)
:33)

Quit Alb+F4

&P Project [O2 Callree | B used by

Danrload the current project to the FLC

foffine [

Project > Transfer > Download to PLC... > Confirm the following notes ("Transfer to PLC", ....) with OK

9. Turn the mode selector switch of the CPU to RUN position
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6.9.5 MTR-DCI/SFC-DC-motorcontroller

e Motorcontroller: MTR-DCI, SFC-DC
e Programmiersoftware: Festo Configuration Tool FCT 1.0.9 or higher

Switch on power supply unit

Switch on the compressed air supply

Release the EMERGENCY-STOP pushbutton (if available)
Start the PLC programming software FCT

Dearchivate the file 13LA_FCT.zip

v~ W N -

Note
Do not unzip the following ZIP-Files using WinZip® or similar software.
Please use the Festo Software FCT instead.

=l8ix
FESTO

Open project Hew project

Project > Dearchivate - Select the project file 13LA_FCT.zip - Confirm selection with OK - Confirm the
following note (“project successfully dearchivated”) with OK
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6. Open the project file

—i8ix]
Project  Devie  Yien  Extra  Help oot
- 1

Bl prosects |- voct | € secnc

R Project; Lagern
E

£ MTR-DCT: MTR-DCT

[ Praject
Mame: |Lagem
Tile: |Lagern
Created: ’—m“gmg version:  [70.0 Author |§H
Hodfied [author [ Description
Description
penproect | hew project

General Output

|Ready

7. Select devices and go online

n eI
Broject  De [ Help ===
g Yl B

[Workspacs B[ prgects [ Mrrper+ | @ srcoc
=458 Froject: Lagemn

(58 Devices Mokor type: MIR-DCI-425-GI 44210 7
=120 MIRoC MTRDCT | otor et |
@ Motor
£8 Honing Gear type! (ST 2 Upload

Mechanics 2
a Tnterface type: 10 Multipole /O Devnioad

Pasition szt table
B intertace =
SFCDC: SFCDC Devce dta T
Manufacturer: Festa AG & CoKG Store.
Device bype: o
Hardware version: o204 Help
Frmare version: VD 1,19

Kl I»]

General Outpt

[Ready

Select devices - Select MTR-DCI from the project register/devices and connect PC and motor controller using the
RS232 programming cable - click Connect device > the online connection will be assembled.
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8. Download the project to the motor controller

Bl Festo Configuration Tool - Lagern

Broject  Device Yiew Extra  Hlp

El==

-18]x]
FESTO

BB | projects [0 MTR-DCI* | @ 5Fcnc

R Project: Lagern
(5 pevices
1D MIR-BCL: MIR-BCT
@ votor

10 Horing velocity v_1p

Horning method:

s zero point;

lechanics Homing velocity v_zp:
B Postion set table
Rl makor currert;

Interface
st reac

4 12|

Ref switch positive ~ @

186 °

Corkinue >

Uplaad
Download
Syre.
store

Help

General Output

@stare| | ) 556509 Lagern_storn... | [ Festo Contiguration 7.

« QT 1rse

Download - Select reference drive from the menu section “MTR-DCI“ - Select Download - Confirm following
note (“Perform Download?...”) with Ja.

9. Check the positioning behaviour of the axis, reference coordinates

and working area

ST

FESTO

[worspaee & byt [ MiR-DCI | 9 SPCDC

eeeeee Homing method:
s 2er0 point:

Horring velocty v_rp:

B Lle

Horing velocky v_2p:
B imerrace Rel motor currents
=8 e srenc
4 controller
B Interface

[Ref switchpostive =] 9‘
165 °
RS
B

80 %

Continue >

Upload
Dawrload
Syne
Store.

Help

Travel data
ode: ncrenene: I
state: velacity: [ s
Enable: @ Ready: O
Start: (o} me: O Single step: >
Error er— ContinuoLs: R |
[ oo -
‘ ¥ FCT control ¥ Enzble Aeseteno | ‘ Accept a5

g

Bl output | B operate | B Manual move
General Outp

|Ready

Manual move/reference drive - Select Manual move from the menu = Select FCT control and Enable in the
menu section “Manual move* > Change into menu section “reference drive“ - Execute the reference drive >
Confirm following note (“Homing successful®) with OK.
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& Festo Configuration

Eroject  Device

EELTI=

—[81x]
FESTO

[Workspsce &
=458 Froject: Lagemn
£ Devices
=123 MTR-DCL: MTR-DCT
@ Motor
2 Homing
&\, Mechanics
Position set table
B intertace
& SFC0C: SFCDC
A controller
5 Interface
~£2 Homing
&\, Mechanics
Position set table.
I Closed loop settic

Projects |2 MTR-DCI | € sFC-DC

Postior|  Velacky| Comment
[s]

Rec,| Mode
AAIR} [
)
1
] 2
[ s
[] 4
[ s
[ 16
[~
D[ Emr—
HER
10 A 65,5
[l a 81,5
[112 a 7,5
[113 a -113,5
[ & -0

30 Drehposition B rotary position B
0 Drehpasition C | rotary pestion ©
30 Drehposition D | rotary postion D
30 Drehpasition E ] rokary position £
30 Drefposition F | rotary position F
30 Drehposition G | rotary postion §

Continue >

Upload
Download
Syiic
Stare

Help

Mods; [Position profie mode
Stake: oz
Enable: @ Ready: e}
o o we: O
Errar: o
‘ ¥ FCT contrel ¥ Enable | ‘

Tncrement: 01 °
Velodty: 5 cis

Teach
Single step: >

Actual position

Accept as position no. &

B output | E] Operate | Bl Manuai move

General Outpt

[Ready

Manual move/position sets > Change into menu section “Position set table“ - Select position set and carry out
- if necessary, optimize the position sets in the menu section “Teach* and safe modifications with

Accept as Position no....> Select Download and confirm following note(“Perform download?...) with Ja = after
successful download disconnect the online connection and conform following note

(“Store device data permanently?) with Ja.
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Repeat working step 7 to 9 with the motor controller SFC-DC.

7. Select devices and go online

ll Festo Configuration Tool - Lagern _i8ix

Froject  Device View Extra  Help FESTO
553 &6 ED

Bl | erojecis | 29 wrroct (& scooc |

B ' Project: Lagern
9 ceries Contalertpes EEE e
5 WIR-DCE: MTR-DCT =
51§ sreoc sreoc s |
&
=
Uplad
B Potnoc b | ~Dma s (e
Clasedoop <2 | | iy facturer Festo G & Coka Store
Hardware version: voLon
Fimware version Vot e
4l B |
el Output

[Ready

Select devices - Select SFC-DC from the project register/devices and connect PC and motor controller using the
RS232 programming cable - click Connect device > the online connection will be assembled.
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8. Download the project to the motor controller

lFesto Configuration Tool - Lagern =l=ix]
Project  Device  Yiew Extra  Help FESTO
g - 1G]
[workspace % |{projects |9 Mrm-0ct [ seeoc |
= R Profect: Lagern
@'ngf Homing methodt Block negative 2 @I _ontie > |
- EE MTR-DCT: MTR-DCL i Zr0 poirt; 1,00 mm ey
16 SFCDC: SFCDC . oo ion _IEE
8 Cortrollr ioming welocity v_rp: L0 mmfs.
Y intertace Hominavelocty v am: | 10,0 mmis Upload
L2 roring . | <
Q rboies . motor currents %

Download
- [E] Position set table ownleas
b Closedloop settir e

(—® Positive

[— Negative
Help

General Cutput
|Ready

Download - Select reference drive from the menu section “SFC-DC* - Select Download - Confirm following
note (“Perform Download?...”) with Ja.

9. Check the positioning behaviour of the axis, reference coordinates and working
area

EllFesto Configuration Tool - Lagern =[81x]
Projct  Deviee  Vien  Exbra  Hsk FESTO
g 1]
[Workspace ——— # [ prgjects |9 w0t [ sreoc |
=] ' Project; Lagern
) Devices Homing methodt Block negative 2 _I@ _contrue > |
23 MTR-DCL: MIR-BCI #ixis 2610 point: 1,00 mm Py
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[Ready

Manual move/reference drive - Select Manual move from the menu - Select FCT control and Enable in the
menu section “Manual move* > Change into menu section “reference drive“ - Execute the reference drive >
Confirm following note (“Homing successful®) with OK.
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6. Commissioning
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Device control Actual position; [~ 5,83 mm
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[Ready

Manual move/position sets > Change into menu section “Position set table“ - Select position set and carry out
- if necessary, optimize the position sets in the menu section “Teach* and safe modifications with

Accept as Position no....> Select Download and confirm following note(“Perform download?...) with Ja = after
successful download disconnect the online connection and conform following note

(“Store device data permanently?) with Ja.

Note

¢ In condition at delivery the Storing station is already commissioned and the
positions/reference points are teached.

o After transport or modification it is possible neccessary to align
positions/reference points again.

e For normal commissioning the Storing station execute the RESET and start the
sequence.
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6. Commissioning

6.9.6 Position set tables MTR-DCI/SFC-DC

Position set table rotary axis MTR-DCI

Positon PLC E4(23)/ E3(2%)/ E2(2Y)/ E1(2%)/ Mode Position v Comment

set Byte 24V ouT 2 ouT1 ouTo (A/R) [in°] [in°/s]

(E4...E1) (E3...E1) (XK4) (XMA2) (XMA2) (XMA2)

8 0 1 0 0 0 A -33,5 30 rotary position A,

rack positionl

9 1 1 0 0 1 A - 49,5 30 rotary position B,
rack position 2

10 2 1 0 1 0 A - 65,5 30 rotary position C,
rack position 3

11 3 1 0 1 1 A -81,5 30 rotary position D,
rack position 4

12 4 1 1 0 0 A -97,5 30 rotary position E,
rack position 5

13 5 1 1 0 1 A -113,5 30 rotary position F,
rack position 6

14 6 1 1 1 0 A -136,0 30 rotary position G,
Holder module
position

15 7 1 1 1 1 A -16,6 30 rotary position H,
pick-up point,

reference point
rotary axis
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6. Commissioning

Position set table Z-axis SFC-DC

Positon PLC E5(2%)/ E4(23)/ E3(2%)/ E2(2Y)/ E1(2%)/ Mode Position | v Comment

set Byte ov oV 0ouT 2 ouUT 1 ouTo (A/R) [in mm] [in

(E5...E1) | (E3..E1) | (XK&) (XK4) (XMA2) | (XMA2) | (XMA2) mm/s]

0 0 0 0 0 0 0 A 0,00 10,0 Height 0,
reference point
Z-axis

1 1 0 0 0 0 1 A 0,00 15,0 Height 1/driving
rack level 1

2 2 0 0 0 1 0 A 20,00 15,0 Height 2/storing
rack level 1

3 3 0 0 0 1 1 A 63,00 15,0 Height 3/driving
rack level 2

4 4 0 0 1 0 0 A 85,00 15,0 Height 4/storing
rack level 2

5 5 0 0 1 0 1 A 133,00 15,0 Height 5/measuring
colour identification

6 6 0 0 1 1 0 A 126,00 15,0 Height 6/driving
rack level 3

7 7 0 0 1 1 1 A 150,00 15,0 Height 7/holder
module, pick-up
point, storing at
rack level 3

Notes

© Festo Didactic GmbH & Co. KG ® 696683

Five outputs of the I/0 -terminal (XMA2) are decided for controlling/calling the
position sets via higher order controller/PLC.

The position sets are selected via the binary code of the I/0 -terminal (XMA?2)
outputs Out 0.2/0ut 0.3/0ut 0.4

(corresponding input E1 /E2 /E3 of motor controller SFC-DC and MTR-DCI).
The input E4 of motor controller MTR-DCl is wired to 24 V (XK4)

(signal HIGH, cause of position set 15, homing),

so only eight position sets (8..15) can be freely selected via binary coding.
The inputs E4 and E5 of motor controller SFC-DC are wired to 0 V (XK4)
(Signal LOW, cause of position set 0, homing),

so only eight position sets (0..7) can be freely selected via binary coding.

The position set sequence is started via the I/O -terminal (XMA2) outputs
Out 0.5 (corresponding input E5 of motor controller MTR-DCI) and

Out 0.6 (corresponding input E8 of motor controller SFC-DC).
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6. Commissioning

6.9.7 Positions of the position sets MTR-DCI/SFC-DC
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G F E D C B A H (Reference travel
| i i i | rotary axis)
| | | | |

\ \

\
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6. Commissioning

Example
Storing position B4

© Festo Didactic GmbH & Co. KG ® 696683

Set the binary code of the rotary axis to ,,Rotary position B“
(Out0.0=1,0ut 0.1 =0, 0ut0.2 =1).

Activate the motor controller MTR-DCI

(Out 0.5 short-time at 1).

Set the binary code of the Z-axis to ,,Height 4
(Out0.0=0,0ut0.1 =0, Out 0.2 =1).

Activate the motor controller SPC-DC

(Out 0.6 short-time at 1).

Wait until both positions are reached.
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6. Commissioning

6.10
Starting the sequence

58

N =

Check the voltage supply and compressed air supply.

Remove the workpieces at the transfer points of modules or stations prior to
manual reset.

Carry out the reset sequence. The reset sequence is prompted by the
illuminated RESET pushbutton and executed when the pushbutton has been
pressed.

Place a workpiece in the workpiece receptacle.

Start the sequence of the Storing station. The start is prompted by the
illuminated START pushbutton and executed when the push button has been
actuated.

Notes

The sequence can be interrupted at any time by pressing the EMERGENCY-STOP
pushbutton or the STOP pushbutton.

With the key-operated switch AUTO/MAN, you can select either the continuous
cycle (AUTO) or individual cycle (MAN).

The following applies in the case of several stations:

The individual stations are reset against the material flow.

The indicator light “Rack module full“ is illuminated if one of the rack levels is full
with workpieces (6 workpieces, mode storing). Remove all workpieces and
confirm by pressing the START pushbutton.

The indicator light “Rack module empty* is illuminated if one of the rack levels is
empty (no workpiece, mode retrieving). Fill-up the rack module with workpieces
and confirm by pressing the START pushbutton.
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6. Commissioning

6.11 6.11.1 Networking

Combination of stations
In the standard version, the MPS® stations are linked using optical sensors. This
type of linking is known as StationLink, which uses through-beam sensor
transmitters and receivers as sensors. The StationLink transmitter is mounted on
the incoming material side and the StationLink receiver on the outgoing material
side. By switching on or off the StationLink transmitter, the station signals the
upstream station whether it is ready to receive a workpiece or busy.

The sensors for linking several stations must be arranged face to face in alignment.

The linked stations must be securely interconnected by means of hammer head
screws.

Note

¢ Inthe case of the Distributing station, only the StationLink receiver is mounted.

e Inthe case of the Separating station two StationLink receiver are mounted.
¢ Inthe case of the Sorting station only the StationLink transmitter is mounted.
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7. Maintenance

The Storing station is largely maintenance-free. The following should be cleaned at
regular intervals using a soft fluff-free cloth or brush:

e The lenses of the optical sensors, the fibre-optics and reflectors
e The active surface of the proximity sensor

e The entire station

Do not use aggressive or abrasive cleaning agents
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Updates

Up-to-date information and additional documents for the Technical documentation
Oof the MPS® stations please find at the address:

http://www.festo-didactic.com/ Services > MPS
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